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| ProcessSensorData()

A 4

mmWave Task

A 4
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l
1
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1
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|
1
|
1
l
1
l
1
|
1
|
1
|
1
|
1
|
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l—:—>| Semaphore }
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2-10 12, Bo W ) =RV TR =T DT —F py—heRmLET,

I ProcessSensorMsgEvt() I

4—

SENSOR_MMWAVE_EVT

mmWave Task

Wait 20 seconds for the
mmWave to power up

MMWAVE
SENSOR?

| mmWave_init()

A
readmmwave()

» Wait for mmWave sync word

« Parse mmWave frame [—

« Save frame header, number of

objects and object information

Set SENSOR_MMWAVE_EVT
event

A 4

I semaphorePost() l—
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/%!

mmwave Object Field

typedef struct _Smsgs_objtrackingfield_t
{

uint32_t tid;

uint32_t posx;

uint32_t posy;
} smsgs_objtrackingfield_t;
/-.':I

mmwave Sensor Field
typedef struct _Smsgs_mmwavesensorfield_t

/*! mmwave frame number */

uint32_t frame_number;

/*! Number of objects detected */

uintl6é_t num_objs;

/*! Tracking information for each object */

Smsgs_objtrackingfield_t objInfo[SMSGS_SENSOR_MMWAVE_MAX_OBJ];
} Smsgs_mmwaveSensorField_t;

2.2.4.3 SUBtHEBHEIACN YR FDEE

DOFFHTIL, 7 7 4/VNCHEIEREE R ME S E T, E72. lowpower LT pointCloudEn =< Ri%, 7 7 4/L b=
<7/]\ YAREHHE L T FOINICE TSN ET,

1. ES1.0 IHMEWHEE HT—RE24HALZRW=0. Tlowpower 0 1\r) % lowpower 0 O\r (ZZE L, (K42 )£ —F
ZIENZT D

2. WAVRITUREESZTBiBIMa <R pointCloudEn O\r] Z BN, CC1352 T /3A AN et A D7 L — L% /)N
KT HZET, AHAKET S

const char *CommandList[] = {"dfeDataoutputMode 1\r",
"channelcfg 15 5 O\r",
"adccfg 2 1\r",
"adcbufcfg 0 1 1 1\r",
"profilecfg 0 60.6 30 10 62 0 0 53 1 128 2500 0 O 30\r",

"chirpcfg 0 0 0 0 0 0 0 1\r",
"chirpcfg 1 1 0 0 0 0 0 4\r",
"framecfg 0 1 128 0 50 1 O\r",
"1owPower 0 1I\r",

"guiMonitor 1 1 0 O\r",

"cfarcfg 6 4 4 4 4 16 16 4 4 50 62 O\r",
"doacfg 600 1875 30 1 1 O\r",
"SceneryParam -6 6 0.5 6\r",
"GatingParam 4 3 2 O\r",

"StateParam 10 5 100 100 5\r",
"AllocationParam 250 250 0.25 10 1 2\r",
"AccelerationParam 1 1 1\r",
"PointCloudEn O\r",

"trackingcfg 1 2 250 20 52 82 50 90\r",
"sensorstart\r"

};

R ERHEE — R OMHOTEOFMIC DU T, TUML — 5 — s 2B LT NEGEBE | FHRIOYT 7L 2079
LI BILTES,

23 FOMERARM
TIDA-010022 7 A2, BL FOT A ALGHI T Z v b7 4— 2 (EVM) DS TOE T,

1. IWR6843: 7 /F v/ 60~64GHz IV 4

2. CC1352:SimpleLink @HHET 27 /L RUR U AR L Rew AT

3. IWR6843ISK & MMWAVEICBOOST : Vi EVM

4. LAUNCHXL-CC1352R1:SimpleLink™ < /L F /3K CC1352R UVA-¥L A+~ LaunchPad™ BiZ %k
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2.3.1 IWR6843: 2> L FvT 60~64GHz 2Kt

IWR1642 7 SARAIZIX, VT ayr 2Rkl 2 HON LV AIy 2L A HOL L —3"DTb DT Fal « R—2Z/N R ey
TF N TFz—r BIOBEKN T BT LA[EEZR MCU £ DSP R & FITWVET, IWR1642 (X, TXTD AEGEF
W/ BEREERE A LB E T,

ZOVT 7L AT AL TiE, IWR1642 57341 2% CC1352R SimpleLink 7 2.7 /L 3R« U A YL A MCU SfLAA
T, AEEH /BT —Z DU YL @ L ATREICLE T,

| Serial Flash
T I QSPI [ interface
RX1 44— LNA IF ADC Cortex-R4F
! @ 200-MHz SPI Optional External
T MCU interface
1 (User programmable)
RX2 4+— LNA IF ADC
Digital Front PMIC control
End Prog Data Boot
RX3 4+— LNA IF ADC I | P 5 N « | ROM DCAN Optional communication
] (Decimation | (256KB*) | (192KB*) |— pronel
T filter chain)
RX4 4— LNA IF @ | £ DMA
| : (o H—
2 Master subsystem
@ (Customer programmed) Tost JTAG for debug/
T < development
TX1 PA -
L ——— -
High-speed ADC output
T | | interface (for recording)
TX2 PA x4 Synth Ramp ) '
(20 GHz) Generator L ?lgg-spee_d \Input for
- ardware-in-loo
| | C674x DSP verification i
@600 MHz
ADC
Buffer
; |
RF Control/ | L1P L1D L2
BIST (32KB) | (32«B) | (256KB)
= Osc VMON i | |
= | X emp CRC Radar Data Memory
(L3)
DSP subsystem 768KB*
RF/Analog subsystem (Customer programmed)

* Up to 512KB of Radar Data Memory can be switched to the Master R4F if required

2-11. IWR6843 O JAvs/HE

2.3.2 CC1352R:SimpleLink™ BERET 1T I I\VF DALV L R (Y

CC1352R T /3 A AL, VAL A M-Bus, IEEE 802.15.4g. IPv6 xfii5A~—hk-A47 =7k (6LOWPAN), Thread,
Zigbee®, KNX RF, Wi-SUN®, Bluetooth® 5 Low Energy., BL UM H AT L& x5 L LTz, ~/VF 7 ahaL
Sub-1, 24GHz VA¥YL R~ A2 T,

CC1352R T/ A AL, IANDRITENTBIRIEE T /1D 2.4GHz 35108 Sub-1GHz RF 7 /3 A A 5725 CC26xx
BER CC13xx 77 OB CF, 77747 WD RF 5L U1 70a ba—F (MCU) B 5 I 5< L fok
80KB ® RAM ZARFFT DAY —7 BN 1A ITHET272\ 2 /3y T UBREhRE AN R /N S7pa A U AL B M OB BE 7
BT 7V r—var THEIERRE T,

CC1352R T /A AL, ZLF T 7 VBRI E S )] RF 72 v — 3Eif )72 48MHz Arm® Cortex®-M4F CPU % 1
DDOTTINT+—AMIHEA L, BEOWEE L RF g2 R — L CWET, EHAO R ha—T (Arm®
Cortex®-M0) |% ROM F7-i% RAM [Tk ME L2 —L UL RF 7 ahajl o< R BIEN S E L En -
TLXR VT AZMER L ET, CC1352R 7 /3 A AT AXTH#EFE ) T RF PEREARRIEIC T, AU/ LB 7
HE (RIRMEL 7 a0 7)) 2 COE T,

CC1352R T /A A, BEICHASNTZEOL I NF T I/ a—arThh, 5887 RF VAT AEF L F T
DC/DC @ " —HEWNHL TWET,

CC1352R 7 /3A A, SimpleLink™ <=2 (MCU) 77V 74— LD—F T, KT Tvh T4 —AlL, T2
7 SDK (Y7 hy =T BRFEF v R) LB E Y — L -y Mo 2 7ol W0 W IHE O B BRI A I 35 WI-Fi®,
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www.ti.com/ja-jp SR T AW
Bluetooth® Low Energy. Thread. Zigbee, Sub-1GHz MCU, 33X UYAN MCU THERLEIL TV ET, SimpleLink 7
FIRT A — DI —ETHRELEEHTE, W TAL T T DE DT INRAZDMAEHE THREHBINTELD T, #%E
BHEFEOELI—RO 100% BRI AEETH, 2OV T, tij.co.jp/simplelink 22 & <72E0,

ZOUT 7L AT YA T, CC1352R AL T, IWR1642 Z4I8IEL, TAFL Ao o by — 2B L
T T RTONEGHA /BT — 5% o M — 2 CEE L ET,

CC1352R 6\,«* K

RF Core

Main CPU

Arm® Cortex®-M4F

Processor Up to .
352KB Digital PLL

Flash
with 8KB

Cache DSP Modem

Up to Arm® Cortex®-M0
80KB Processor
SRAM

with Parity

General Hardware Peripherals and Modules Sensor Interface

I’C and I’'S 4x 32-bit Timers ULP Sensor Controller
2x UART 2x SSI (SPI) 8-bit DAC
32 ch. pDMA Watchdog Timer 12-bit ADC, 200 ks/s

28 GPIOs TRNG 2x Low-Power Comparator

AES-256, SHA2-512 Temperature and SPI-I%C Digital Sensor IF
Battery Monitor

ECC, RSA RTC Capacitive Touch IF

Time-to-Digital Converter

2-12. CC1352R O7Av/K

2.3.3 IWR6843ISK & MMWAVEICBOOST: 3!l EVM

IWR6843ISK & MMWAVEICBOOST I3, Vil EVM NN—RU =7 + 7 I 7 4 —LDO—E T, TH PR AL AV RA
VD IWR6843 FEEFAAY —4 b (IWR6843ISK) i, IWR6843 IV I 7« T /3 A AT DTG
ERTHY, ZOR—RIZIL, 7o T T2y F o 7L —F —Ta bRl —RELUTHERET 5 60GHz VKL
— B "G = AR EEN TV ET, MMWAVEICBOOST X, T X TOAZ—HF - F o hTHEHAINETF R AR
VN AY DIV AEHTETRA L AR =R THY, IV IR L TEVEL DA H—T A AL PC
At £9, MMWAVEICBOOST R—RiZ. mmWave Studio > — /L3 L —& —« 531 2%+ %L . DCA1000 FF
AR (EVM) 728 DX 7 F - IR —R 2 L TRIN T AID =2 23—% (ADC) DF —Z &%+ 7 F v 572D DA
UHE—T oA AERALL F97, IWR6843ISK & MMWAVEICBOOST 1213, A>T w7 C67x DSP =7 H{KIE 5 /7
D ARM R4F 2 ha—FHOY 7 =7 OBFZ RO T2 I BERLEONRT X TEHEENTWET, 40 D
LaunchPad™/BoosterPack™ =%/ %% L T MSP43xx ;R —REDA L HF—7 = A A% ML ET,

IWR6843ISK 7 /S A AD F 72 F K& LA FITRLET,
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LVDS #H DA T AID 22 /3—% (ADC) 7 — X B LU — - 7 — 2 HHe D 60 B2 D@ E EE (HD) 027
7

R R K77

FTARTOL—LVHAOEF

Z> AR —F PMIC

MMWAVEICBOOST 7 /A AD EFEZLL FITRLET,

CSI F7-13 LVDS #% M D& ADC 7 —#B LT I2L—2{E 5 I 2 A0 60 Eo @as B (HD) =p s 2%
T HRAR AL —H 3k

AL =B Xy NCT Ty a7 al I3 T 570D IT VR —r i 27z FTDl X—2®D JTAG =2l —3
N

XDS110-UART X—20D QSPI| 79w a7 u/I37

DCA1000 EVM ¢ DAL 2 —T A A D 60 £° HD ox 7%

FHRA R AL AL A VFEYE Launchpad DTy 2T LEIERL, L—F —F o7 LD XTHOT DXLl
HEREA (i 2T\ 5 2 D 20 ¥ LaunchPad =274

2 HOA L HR—Rarta—7- Y7 - kI —7 (CAN) hFo v —3

Z AR —K PMIC

JTAG FL—2H D 60 B> MIPI HD =2r7 4

DUT XY T 2TV (B2 —T A A (SPI), LA AT (GPIO) #il4, LA FEREAEZ E8 (UART) =/ — o
PC A ¥ —T 2 A RXEHRMT B, AR —F FTDI Fv 7

T R—ROEF R ERERY

ZDOVT7 L AT AT, IWR6843ISK & MMWAVEICBOOST ZAf# L T, IWR6843 M9 X TOMREL VR
—hLET,

2.3.4 LAUNCHXL-CC1352R1:SimpleLink™ < )LF/\>F CC1352R 7/ LRI/ LaunchPad™ Bi%+y

~

CC1352R LaunchPad (LAUNCHXL-CC1352R1) 1%, CC1352R v A2 ##H#H L =T v R - ah A7 HO~A
a %Y TT,

e PCB ]\V‘—X'T‘/?‘“j‘%f*gﬁb\ Sub-1GHz ﬁ%fﬁi:ﬁﬁ&,f:y(kl/;.7709,7_:/3\/WH LaunchPad
TI—RANUR T UTFFIZED 1 DDOR—FTERIN D 868MHZ ISM /S &K [E 0> 915MHz ISM /3 R H-7RK—|
FUR—ReI2l—#|2kY CCS Cloud THOa—RBAFEDOHRE BRI T HE

LaunchPad k& SmartRF™ Studio 77"V — a2 Cffi F A HE

BoosterPack 777 A+ &Y 2— /L DARIZTETRTD |0 ZITT /1A

LCD 7 —AZ w7 L H i

ZDOVT7 7L AT HA LT, 2 fHld CC1352R LaunchPad Z{EHL T, B ¥-aL s ko N\ —r5 8L E
‘g—o
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3.1 BEQGN—FITT7EVYTRITT

LFDEI 2 Tid, SuUb-1GHZ V7 7L A T WAL DIV L —F — o2 U CAZGHE [ B2 B ik
TAEDITNIE I N—RT 2T L 7R 2 T IZOWCGHRIAL £,

311 N\—F91785E

TIDA-010022 D7 HAAZE, L FDOAN—RU =T 3BT,

o WP X T B —R T Ty T +—2 (MMWAVEICBOOST)

o IWR6843 1EHET T FHEH AL TV = MY DT T T A - EY 2—/1 (IWRE843ISK)
+ 2 5% CC1352 LaunchPad (LAUNCHXL-CC1352R1)

« 5V,25A LI E® DC &K

-

IWR6843 RN —RIZN—FV =7 DEFEZMALAN, EZar 312 DFIEICHESTT Ty 2 LET,

CC1352 LaunchPad (%, W <O D/N—R7 =7 DEF #1772t . MMWAVEICBOOST AR —R{ZHfi TEET, #

3-1 12, MMWAVEICBOOST R —RD/AN—RU =7 D 4R~ LET,

% 3-1. MMWAVEICBOOST /\—FJz7DER R

MODIFICATION (Z£%.5)

REASON (#H)

R91 #EAS LaunchPad %% RADAR _HOSTINTR1 t"> % Gl
R81 Z3B 0 LaunchPad (= RADAR_MSS_LOGGER b %45

R122 ZB0NL . J13 B 2-3 [T 3B

CC1352 LaunchPad @ 3.3V L —/L{Z MMWAVEICBOOST A—R® 3.3V L —/b

PLF DI mux &K,

S$1.1 47 :SPI1 (F74/1F)
S1.147:SP1 (T 74/Lh)
S1.2F:40 B

S1.347:40 116

S1.4 4> :FTDI/4 ©1J16 (F7A/LF)
S1.5 47:40/60 £°//FTDI

S1.6 47:40/60 &> (F74/L1)
S1.7 47:40/60 &7

S1.8 4 :40 v

S1.947:60

S1.10 A :FTDI

S1.11 4 :FTDI

$1.12 #>:XDS110 (F 74/ 1)

A A B —T A A A X —T I

MMWAVEICBOOST R —KRA B0 LD 5 R— R M, [ 3-1 DAV T~ — /S COET, BN
FHUERDDHA H—F ML, FOE TR TOET, IWR6843ISK AR —R CHEZE H I3 R T,

3-1. MMWAVEICBOOST Z7A>k PCB LA 7k -Ea—
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ot ) —RELTHE A% CC1352 LaunchPad (213, WO DEERNETT, LTIy _RERsLET:
[5V], I3V3) . IRXDJ. TXDJ, #LC. XDS110 EIR v & [44E8 | EBIFRIZEV#E x F4°, CC1352 LaunchPad &
ST LT (IR0 JT) FED SMA =525 % 04+ L C. MMWAVEICBOOST R—R L4k L £ (1 3-2 4%
)

e}

alL gk )—REU T 4% CC1352 LaunchPad O/ N—RT7 =7 22 H 450 IHYFR A,

BTH-1 3
BIOIS @
5

@, @yoice
Q qo101s
Q'@oios
0 a

Remove this
SMA connector

.
E204440

M1 § S4V-0
© 2511 e

Meynt for
CC- ANTENNA-DX

B 3-2. CC1352 M SMA aRV4ZMYNT (Lo ¥ -R—F)

T AR_RCON—RT=T OEENET LI2% . IWR6843ISK /R —K, MMWAVEICBOOST "R —FK, 33X CC1352
LaunchPad @ 1 S&fAEbE T ¥ —FEEMA TEET,

Y- /—kK (IWR6843 7R —F + CC1352) (213, 5V &EliZ MMWAVEICEBOOST R —RIZ#fi 452 & TRz it
FC&E, AL s X/ —RIZiF, USB Bz iEki o2 L TRzt TE £,
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usse
Power
Supply

B 3-3. 24+ /—F (IWR6843 K—F + CC1352) B
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3.1.2 Y9I TERE
3.1.2.1 CC1352 Z7r—A DT 7DO—F

LA FOFINEICHEST, CC1352 LaunchPad (27 7 — AT =T 22 —RLE1,

1.

http://www.tij.co.jp/tool/UNIFLASH 7> UniFlash #% 7o —RLET,

2. UniFlash A%, &/ —Realb sz )—R% PC IZHHEL £7,

*®
IWR6843 78 —R~& CC1352 LaunchPad Ot b7 7 OFEAIZOWTIE, B/ a 341 5L T
LTEEWN,
CC1352 % PC (28t 3 D&, UniFlash 13457 A AL ET,
b2
Bt ) —ROTRT T NIE BV EIRE USB 77— VORI BT T RN, av sy ) —Ro7ar
T AIZIE USB 77— 7 )LD BN LETT,
T T NTHT INARENATARL, [Start) RE 27V 7L ET,
[Program &2 a>®DIFlash Image(s)| . [Browse |?hZ %277 LET,
a. ALIEOT7— AU xT Zu—RT 55451, TIDA-010022 firmware 7 4/ 2 2B EIL |
collector_cc1352r1lp.out 7 7 A /L &38R L £,
b. BV OT7r—Ly =T Er—RT 554513, TIDA-010022 firmware 7 +/L4 ([ZEE)L
sensor_cc1352r1lp.out 7 7 A /L &&IRL F7,
ELWAA—=T T 7 AL EIRLTZ5, [Load Image | RF &7V y 7L ET,
A A=V NIEFIZr—REN 7254 1%, [[SUCCESS] Program Load load completed successfully ] £\ ) At —
VINFIRENET,

~ Detected Devices

Status; e Active- Monitaring for changes Sefting:  Auto

Device: CC1352R1 LaunchPad (Dual band 868MHz and 2 4GHZ)
serial Number: LATODTAK

Start

~ New Configuration

@ Choose Your Device

o LAUNCH
& LAUNCHXLL 2R1
< LAUNCHXL-CC1350 LaochPad . OmChip

3-5. RSN =T/ (R

16
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I Pragram Select and Load Images

Settings & Utilities
Memary

Standalone Command Line

Flash Image(s)

collector_cc1352r1 Ip.out

Avall A(s) - 1 Image Selected
Losd Imege | Verify Image

Reset Actions

= Quick Sattings:

ur personalize settings view, Click to add settings.

O Consale

[7/6i2018, 7:26:21 PM] [INFO]
[7/6r2018, 7:26:24 PM] [IN
[7r6/2018, 7:26:26 PM] [INFO]
[7/6/2018, 7-:26:31 PM] |

GEL Output

W4_0: GEL Qutput: Memo

3-6. FA—OO—FIZFHT)

3.1.2.2 IWR6843 Z7—AL 7T F7DO—F

ZDVT 7L AT H A%, mmWave Sensors Industrial Toolbox v. 3.2.0 (25 F415 68xx People Counting 7 &
FHDONRAFV A A= CTT ARSI TEY, 2R E ENTOET,

LT OFNEICHEST, IWR6843 77— LU =7 Z#0—RLE T,

Size' 3.88 MB | Binary ) | X

CC1352 LaunchPad 78 MMWAVEICBOOST A —RIZHEES IV TN Z LA fER L £,

1. 3-7 IR 75912, IWR6843ISK 7k —K & MMWAVEICBOOST "R —RZ A WZHEEGELE 1,
2. 3-7 IR T X9, w2712 USB 7 —7 /L& 5V EIFEZ mmWave R —RICHEEELET,
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XDS-USB
Used for UART and
CCS/JTAG connectivity

SW2 (NRST)
Used for Resetting the EVM

SOP2
Closed for Flashing mode
- Open for Functional mode

B 3-7. IWR6843ISK £ XU MMWAVEICBOOST R—F
3. = USB 7 —7 /% PC 286 L. Windows 7 /XA A< 3— % T COM R —hefEd LET, X 3-8 (2.
mmWave o h7 7 A 2 SOAE COM AR — a2/ AR —h 35 EICOWVWTORLET,
a. XDS110 Class Application/User UART (COMyprr): k7T —Z &7 7— A0 =7 % mmWave R —R |27
OITHEAL £,

b. XDS110 Class Auxiliary Data Port (COMpyx): JLEEE DL —4 — 7 —Z 1 a6(5 T 5720 I L
7

B 3-8. COM R—r DI
4. 3-9 [T k91T, SOPO & SOP2 DYy R aiifi+ 52 LT, MMWAVEICBOOST #77 vy =+ & —RICL%
4, &I, SW2 ¢ MMWAVEICBOOST %#VU+tv kL7,
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MIPI 60PI
JTAG-TRA

B 3-9. SOP0 & SOP2 M fiiiE
http://www.tij.co.jp/tool/UNIFLASH %47 a—RLTHEET,
'New Configuration |z7 2> C, [IWR6843 ES1.0)% L2l CEINLE T,
[Start) %2V 27 U CHAALET,
[Settings & Utilities | %7 %270y 7 LET, By 7>/ T, JlZETHIL 72 Application/User UART COM D7 —h
% - (COM UART) % COM Port D7 % Ak Ry 72 A HLET,
9. [Program|#~ ., TIDA-010022 firmware 74/L4 /5 PC_lab_xwr68xx.bin 7 7 A /L &R L TR O£,

® N O

3-10. @@ O—F
10. SW2 TA—F%VUtvhL, [Load Image |27V L&,
a. IEERT7Iy aOFNEIZLL T OHEY T, UniFlash =2 — L iZid, L F DI ICERSNET, [SUCCESS]
Program Load completed successfully
M. R—ROEREA7IZL, SOP2 x>/ "DAHETVINLET,
12. SOP2 REWASHLTNDHZE | IWR6E843 AR —RDEJRDFHHASIN TWDZEAMERLET, ZAUTLD, A—FE
BEREE—RIZRVET,
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3.1.2.3 Ir—ADOTFDES

PLFOFNEICHEST, oY/ —Reab s ) =R 77— 20 =T&E#B LT, B/ —FDON—Ro=T7 D&k
T FERIEZHDONTIE, BZ7 ar 311 2B BL TSN,

1. BANZ USB EiAMM L CaL s /—FK (CC1352 D 24) OEIRZH AL, #2640 LED IRed:DIO6 ) /3412
BROETRHHLET,

2. 5.0V EFEAMALT, Eo¥ - /—F (IWR6843 7R —F + CC1352) |[ZE A AL ET

3. MMWAVEICBOOST R—K® SW2 (NRST) RZZML T, B/ —RZUEyRLET (1K 3-11 25 ),

4. [BTN-2DIO14) (mLo4 - /—FR L) LT, /—RBRy NI —ZIZB I TELIDNILET, Ry b —I 0B
TWAZEERT T2, a4« )—F BT, [Red:DIO6) LED A3 EHL TWAMLENHYET,

5. BYHDRRYIT—=ZIZHINTHE, SR LED 23 RATLET,
6. [BTN-2DIO14) (L2 %+ /—F k) LT LW =R ARy MU —Z IR TERWIDIZLE T,

7. BUY e ) —RRXRT—ZIZENL ., IWR6843 T NAADEIR DA NI DHET 20 B4 5L, CC1352 T
A AL mmWave R L TEBILET,
8. ky ¥ /—RiaLs&.- )—ROM )T, [Green:DIO7) LED 23, /—REIOEENEIITH- N AEERLET,

BTN-2: DIO14

o @ @

Dlod

PRST

Red: DIO6
Green: GIO7

E204440
il 5 S4V-0
517
Mount for @1 Wt
.- ANTENNA- DN

®)

3-11. LED &RAVDALE
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3.1.24 Z7—ADIFDELF

ZDTHXY AR AL AINVNAY DT AL DT 77— LT 1%, TI15.4 277 CHEftEhLar 742047 -

A—=RIZEDNTWET, Fr T - a—NIRERE R LT 57202, ZOTFY R ARV VAT DT HF AN

T REENTOET, LTFTOFIRICEST, Ny FEEAL, o7 a—REE L RLET,

1. http://www.tij.co.jp/tool/SIMPLELINK-CC13X2-SDK 7>5 Simplelink-cc13x2-SDK (#X—7a> 2.10.00.48) %4
yra—R,

2. Project > Import CCS project Z 541,

3. C:tissimplelink_cc13x2_sdk_2 10_00_48\examples\rtos\CC1352R1_LAUNCHXL\ti154stack 7 4L 7 ) Tl

e ad
o

collector_cc1352r1lp & sensor_cc1352r1lp @ 2 >O7ay =/ AR —h,
5. LLFOISIC, avr&- ) —RIio Xy Tz,
a. collector_cc1352r1lp #4272, Team > Apply patch... 2R
b. L& RyFEiEH (/v T Xl Software Files]1Z&H%)
c. collector_cc1352r1lp #4277 L, IProperties | 28R
d. TlInclude Options iz, ${PROJECT_ROOT}/Application/collector_new 74 /L4 % 3B/l
e. [Predefined Symbols| T, MMWAVE_SENSOR #%iE/l
6. LLTFDIDIC, Bt /=Ry F &,
a. sensor_cc1352r1lp #4272, Team > Apply patch... ZE&4R
b. BLY o F & (/3> F L[ Software Files |128%)
c. Sensor_cc1352r1lp #47U> 7L . [Properties | % 3&R
d
e

»

lnclude Options |12, ${PROJECT_ROOT}/Application/sensor_new 7+ /L4 % B/
Predefined Symbols | T, MMWAVE_SENSOR %8/
7. Code Composer Studio Zff L T/« /—Ra—R&E /LR,
a. [collector_cc1352r1lp | &R TH 2V 7L, [Build Project) % H.oiF, a7y /LT ry =/ L
e
b. oY= JrRIEFEICENRENLSHE, Code Composer Studio D=2/ —/ L FIZ**** Build Finished **** | 533%
IRSIVET,
8. Code Composer Studio Zfi L T2+ /—Ra—R&EE /LR,
a. [sensor_cc1352r1lp ) &i&IRL TEH Y7L, [Build Project) & R olF, a2y /LT a7 e LR
b. eV JMRIEEICENRELSHE, Code Composer Studio D=/ —/ L FIZ**** Build Finished **** ] 233%
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¥¢ Properties for collector_cc1352r1lp

type filter text
> Resource
General
w Build
» XDCtools
v ARM Compiler
Processor Options
Optimization
Include Options
ULP Adviser
Predefined Symbols
» Advanced Options
> ARM Linker
ARM Hex Utility [Disabled]
Debug

U x
Include Options L= 2 v v
Configuration: | collector_cc1332r1lp [ Active ] ~ | | Manage Configurations...
Add dir to #include search path (--include_path, -1) 88 858

S{XDC_INCLUDE_PATH} [ ~
${PROJECT_ROOT}/Application/collector_ new B

S{COM_TI_SIMPLELINK_CC13X2_SDK_INCLUDE_PATH} [

S{PROJECT_ROOT} [

S{PROJECT_ROQT}/Application [

S{PROJECT_ROOT}/Application/subg [~

S{MAC_APPS}/common [=]

S{MAC_APPS}/common/boards []

S{MAC_APPS})/commeon/boards/subg [

S{MAC_APPS}/common/boards/CC1352R1_LAUNCHXL [=]

S{MAC_APPS}/common/apifinc [] b

Specify a preinclude file (--preinclude)

@ Show advanced settings

X 3-12.

o Properties for collector_cc1352r1lp

type filter text

» Resource
General
~ Build
XDCtools
v ARM Compiler
Processor Options
Optimization
Include Options
ULP Advisor
Predefined Symbols
> Advanced Options
» ARM Linker
ARM Hex Utility [Disabled]
Debug

@ Show advanced settings

Cancel
aL%%-/—FKIZ Include Options %380
[m] x
Predefined Symbols =102 - -

Configuration: | collector_cc1352r1lp [ Active ] v | | Manage Configurations...

Pre-define NAME (--define, -D) 858§ Y
S{XDC_SYMBOLS} [ fo)
MMWAVE_SENSOR

S{COM_TI_SIMPLELINK_CC13X2_SDK_SYMBOLS} [

AUTO_START

NV_RESTORE

COMBO_MAC

XPOWER_MEAS

MAX_DEVICE_TABLE_ENTRIES=50

BOARD_DISPLAY_USE_UART

xBOARD_DISPLAY_USE LCD

ONE_PAGE_NV v

Undefine NAME (--undefine, -U)

Cancel

Apply and Close

3-13. aL %4 /—FIZ Predefined Symbols %3&/0
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V¢ Properties for sensor_cc1352r1ip

type filter text

Resource
General
v Build
XDCtools
v ARM Compiler
Processer Options
Optimization
Include Cptions
ULP Advisor
Predefined Symbols
» Advanced Options
» ARM Linker
ARM Hex Utility [Disabled]
Debug

@ Show advanced settings

Include Options (=1 ¥ v

Configuration: ' sensor_cc1352r1lp [ Active ] ~ | | Manage Configurations...

Add dir to Finclude search path (—-include_path, -I) w85
${XDC_INCLUDE_PATH} = ~
S{COM_TI_SIMPLELINK_CC13X2_SDK_INCLUDE_PATH} &=
S{PROJECT_ROOT} []
S{PROJECT_ROOT}/Application [
S{PROJECT_ROOT}/Application/subg [
S{MAC_APPS)}/common [
S{MAC_APPS}/commen/boards []
${MAC_APPS}/common/boards/subg [
S{MAC_APPS}/common/boards/CC1352R1_LAUNCHXL [=]
| S{MAC_APPS}/common/apifinc [ v

Specify a preinclude file (--preinclude) a8 850
${PROJECT_ROOT}/Application/subg/features.h B

Apply and Close Cancel

3-14. >4+ /—FIZ Include Options &0

type filter text

Resource
General
~ Build
» XDCtools
v ARM Compiler
Processor Options
Optimization
Include Options
ULP Advisor
Predefined Symbols
» Advanced Optiens
» ARM Linker
ARM Hex Utility [Disabled]
Debug

Predefined Symbols Qo S

Configuration: | sensor_cc1352r1lp [ Active ] | | Manage Configurations...

Pre-define NAME (--define, -D) LER TR
${XDC_SYMBOLS} [ ~
MMWAVE SENSOR

S{COM_TI_SIMPLELINK_CC13X2_SDK_SYMBOLS} =]

TEMP_SENSOR

AUTO_START

XASSERT_LEDS

NV_RESTORE

COMBO_MAC

«POWER_MEAS

MAX_DEVICE_TABLE_ENTRIES=3

BOARD_DISPLAY_USE_UART v

Undefine NAME (--undefine, -U) L ER AR

A
‘\Z) Show advanced settings

Apply and Close Cancel

3-15. 24+ /—RIZ Predefined Symbols Zi&0
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3.1.2.5 gL o%-T—8H HDEF
a7 He )—K USB I PCITHEERHREIN TWAIGE ., T/3A A~ 32— %d, LLTD COM R— aiRik 4 5 4N HY

£7,

XDS110 Class Application/User UART
XDS110 Class Auxiliary Data Port

% Device Manager
File Action View Help

e T Hm B

e Bluetooth
> @ Cameras
Ij Computer
= Disk drives
» 3 Display adapters
& Firmware
{5 Human Interface Devices
- §2 Intel(R) Dynamic Platform and Thermal Framework
» E=2 Keyboards
> 1 Memory technology devices
> (@ Mice and other pointing devices
> [ Monitors
57 Network adapters
v i Ports (COM & LPT)
ﬁ XDS110 Class Application/User UART (COM18)
m XDS110 Class Auxiliary Data Port (COM19)
= Print queues
1 Processors
B9 Security devices
B Software devices
iq Sound, video and game controllers
& Storage controllers
. 3 System devices
> 8l Texas Instruments Debug Probes
i Universal Serial Bus controllers

& 3-16. COM R—p
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TeraTerm Z &L | [Serial) 2RI T, Rry 7 &7« A=a—7 5 XDS110 Class Application/User UART COM
port ZINL | TOKIARZ %227V 7LET, COM AR—IA, ¥ 3-17 IR T IR ESIN TWAIE MR LET,

Ters Terrr: Senal pert netup

Purt
Speed:
Drata;
Parity:
Stop hits:

Flow condral:

Transmit delay

1 msrcfchat L muecfiine

& 3-17. TeraTerm Ot&vc7vF

ALy ) —ROM N Z T T 572 O TeraTerm v~ 7RG COET, v /rz il 35121%, Control menu %3
L. Macro option ZE4R L ¥9°, TIDA-010022 firmware 74 /L% 12 E1L . mmWave_collector_macro.ttl 28R L
ESS IR

3-18. w40
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3.1.2.6 SUFKBEREDERE
SUAERIZ, LTFTOFIETEERETEET,

1.

2.
3.

tr/iar3.1.24 T —LU=THENARL TNy F A1 L7214, sensor_cc1352r1lp -> Application ->
Sensor_new -> mmwave_sensor.c (2 &)

mmwave_sensor.c D+ T, lconst char *CommandList[]| & 72T %,

MBENIGECTa~ RN, BIbR, F3EEL, B -7 ay= M BT 2,

const char *CommandList[] = {"dfeDataoutputMode 1\r",

"channelcfg 15 5 O\r",
"adccfg 2 1\r",
"adcbufcfg 0 1 1 1\r",

"profilecfg 0 60.6 30 10 62 0 0 53 1 128 2500 0 O 30\r",

"chirpcfg 0 0 0 0 0 0 0 1\r",

"chirpcfg 1 1 0 0 0 0 0 4\r"

"framecfg 0 1 128 0 50 1 O\r",

"TowPower 0 1\r",

"guiMonitor 1 1 0 O\r",

"cfarcfg 6 4 4 4 4 16 16 4 4 50 62 O\r",
"doacfg 600 1875 30 1 1 O\r",

"SceneryParam -6 6 0.5 6\r",
"GatingParam 4 3 2 O\r",

"StateParam 10 5 100 100 5\r",
"AllocationParam 250 250 0.25 10 1 2\r",
"AccelerationParam 1 1 1\r",
"PointCloudEn 0O\r",

"trackingcfg 1 2 250 20 52 82 50 90\r",
"sensorsStart\r"

26
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3.2 TARHER
3.21 FAMER

3.2.1.1 AR Dt TT

B OREREEDITE, BV —FE BHSSRYO LI B2, TS FRIEET T, o@D AL E IR
ETHO0LENHVET, B, 77 B =20 L OH5Ek A CEDIOIC, B ) —RERRETHILET
T AT TFININRETEDE, VTR IT0 LD AR, Bl oo ZHER N LET, F oo F
IVRIRTRNE 5D NISBIID N ENE A TWO TSI TODSE A OFHAMERE MK FLE T, oW/ —RO 7 7t
RE—=UHEZETHE, B ) —F2HFDILICRELZY, =2 RIFITAIT CTRELIZVLARWEICEE 54
ERBHVET, ZOIDNTTDHE, /AKX 7T BEEML ., 2 MEREME T D BEENH D7D T,

K 3-19. >4 /—F (IWR6843 + CC1352) Dtvh 7y

TN OEH::

o« LY =K% 1.5~25m OESICTS

o HULeF K10 B

HWRO=HR~— T3 DI T = NeER LIV T v

1. ZH~Dr5F = ORI ED

2. B ) —RENRT— R LTI D FIZIF T LT Bt S —RETROATT 5,

3. ZHHIOA~YRE T IFEICK 10 BT DI (b b [RT AL YL 228 DA~— T30 T 7V EE LT,
g2 T NI ETED)

4. koY )—R~D BV EIFROFE:

T )= RINT T RIS 1.5~2.5m OESICRD I =z S

6. LY/ —FEL=HoOTRTVE, HEOBBHOSGIICEE TS, B =R L—F—- T 77D 120 &
D FoV 23, L OHAMEIREREREL . A2 NEDZERNIADZER THEINDMHEEIZ R IICEE T2 4N H

o

Do
B 3-20. ¥50F oo EFERL-EYN T YT
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3.21.2 HEES
% (IWR6843 + CC1352) DIEEEIL, T EBIRE 2 T2 TRIETEET,

5V

Bench Power Sensor
Supply (IWR 6843 + CC 1352)
GND

B 3-21. ROFBRICKHHBEENRAEDNE

3.2.1.3 7141 L X RF &g

JA¥L A Sub-1GHz RF D&%, 2 filv> CC1352 LaunchPad Z{# L CHIEL L7, 1 fil®> CC1352
LaunchPad #aL7ZLL T, 69 1 HE2 VL LTy Ty LELTZ, ZOT AT, B ¥ ® LaunchPad (& [EH &
L7 ATOEFIZL T, 2L 74D LaunchPad Z B Fnic B S £ L7-, 2L 7/ Z® LaunchPad B EIL T\5
M, L7203 b T — X a N ZIE L, B Sy IR ICEE SN VAL MR L E L, 2y %
NP EZE CERLA D IR AR EL LT,

3.2.2 TAMER

3.2.21 A B DTIIMER

NEGHA O T AME R OZEMCOW T, [V L —& — 2o S a2 H U2 ABOEEE [ R0 7 7L 2T A0 1%
ZHRLTLIEEN,

3.2.2.2 ERDHIEAE

BHREORE R 3+ 3-2 I RLET, EIX. MMWAVEICBOOST R—FD AN THIELEL-, IEEEBIRITIE.
IWR6843 331X CC1352 R—FR LT X TOF A ANEENET,

& 3-2. EROFEAIE

Y OREE B e

PDRZeAN T RCOR—RRYEyhH 5V x 287mA = 1.44W

TARL VL —F—=DIET 7T 47, TA YL A3 |5V x 500mA = 2.50W
Mol

T W L—F =TI T 4TI NTyF T, U | BV x 670mA = 3.35W
AL AWEHY

3.2.2.3 J4¥L X RF &FD#E
UAYL A RF #iHI%, EEEERTEL R4 7 4 A8 T 70m SHIESNVELT,

ZOHHEESHIZRSTDHENRHVET, Sy 7 PCB 77 OOV AL s ORA YT T o T & HT5
&, IAY LA RF #iFA3 A E T 2R REMEDRSHVET, ©O 1 DO HIER, EHAE MR T OWEEROMIMNE S| EHiz
|2, CC1352 T A ADEIE M & HEMEELHZLTT,
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4 FZEtO7AIL

4.1 EIRRE

R—RHAOEEEXEZL T 1 —R 5121, TIDA-010022 DT H AL 77 AV ESBIRL TTZE,
4.2 &3 (BOM)

R—RHAOELREF T a—R35120%, TIDA-010022 DT AL 77 AN ES LU TITZEN,
4.3 PCB LA 7B T 5HREIH

R—R0 PCB L A7 YN 2RI A 47 m—R 35121, TIDA-010022 OF AL+ 77 A L EBIRLTIES
AN

4.4 Altium 7Oz Yk

A—RHIZ Altium Designer® 7' my =7 X D a—R 351214, TIDA-010022 DT AL 77 AV ESRL LS
AN

4.5 H—/\—J7(L)L

R—=RFHDOH—/N—T7 AN EF T a—RT 5121, TIDA-010022 DT HF AL+ 77 ANV ES L TIIZEN,
4.6 fHI XM

R—RHOMS KM EA2Z 7 m—R 35121, TIDA-010022 OF HF AL+ 77 AN EBIRLTIES N,
592k 7-J74I)L

VIR T T ANEL T a—R T 5HI21E, TIDA-010022 OFT WAL 77 AN EBIRL TEEN,

6 BEEN

TRV R AL ANV AY  [IWR6843 27 VF 7 60~64GHz VoW 5 —4#> —h

THH R ARV ALY [CC1352R SimpleLink™ @EPERET 27 /L« U R T A YL Rev A2 |7 —H—]h
TP AR AR NAY [LP8T702-Q1 ZWHEREM & T 27 VT R —Z B KON BV FE] 7 —4#2—k
TR R ARV ALY [LM53625/35-Q1 2.5A/3.5A, 36V [FIHI#E i, 2.1MHz, %+ DC/DC = /"\—4 7 —
s3—h

5. FERAFRALAY LAY [V — 4 — YA A LT AEGEBE | FHIOYT 7 Lo R F A [T YA 7
"

7 Bt

LaunchPad™, and Tl E2E™SimpleLink™ are trademarks of Texas Instruments.
BoosterPack™ are trademarks of TI.

MATLAB® is a registered trademark of The MathWorks, Inc..

Altium Designer® is a registered trademark of Altium LLC.

FTRTOPEET, FNENOFEEIRBLET,
8 EEIZDOIL\T

LING LIN (X, TF VR A LAYV AY DE )L o F— A= a s VAT W2 V=TV 7 & =T 47 (SEM) D
AL B =T WL —F — B Y LT 2T L UR U A YL AEE LD OO T DV T 7L AT A
Ve Va—varBREEHY L TCOET, 7 RETELSORSEKZTZIE00O Ling 1%, 7TX Y ARFES—AT
A BDRFFRTHEFLET,

GUSTAVO MARTINEZ /3. TX VR AL RV NAY DY =T VAT AT —X% TN ThY  EERT IV r—ard
V7 7L AT AR EZR Y L CVET, Gustavo 13, @tERET 7V r—var -7 ety Fi#l/NERT U XV E
F7atyt RF 77 /00 —7E A~ —h Uy RBLOR— L — A= al AT O AT A DT 7L AT
AL DRI TEERRBREE > TWET, Gustavo I3, ba— AR KFETER THROELBSELEEL ., T3 ARF
T XY TER LFEFE OB EZESEL CVET,

PN~
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CHRISTINA L. LEE (%, TX VA AL AV IVAY DYV AT I T —%T I THY, FEEEFATOV 7 7L AT HA
Ve a—tarfT7r—AU T OBREEHY L CWES, T r—rar - Takyy v Aoy BIOT UV E S
Tty Fa'?]bfrbaaf“b\fi%ﬁ%ﬁ% FAAR T 7— b7 =T HHFLL CWET, TF T ARES—AT AU CTER

BLOmo v a—2T 2%+ (BS) O AL TWOET,

9 WETERE

BEE S REOFFIIUGETER L CWET, ZOSGETEREIT R FERIZEL QO ET,

Changes from Revision A (March 2019) to Revision B (April 2023) Page
o CEARIZOTZS TR, K A B S I OB J7 1R T R et 1
Changes from Revision * (August 2018) to Revision A (March 2019) Page
o FFXaAUPMRIKREEL T IWRT642 % IWRBBA3 1225 T ... oottt ettt eae et eeae et s e e e eteesreeenee s 1
o TUY—2]75 IWR1642, LP87524B-Q1, TPS7A8101, TPST7A88-Q1 ZHIBR...ceeiceeeeeeee e 1
o [UY—2]1Z IWR6843, MWAVEICBOOST. IWR6843ISK, LP87702-Q1. LM53635-Q1 Z 1B ..vevveeeeceeeeeen 1
o TIDA-010022 07 0 B O T 5 B oo e et e e e e e e e e et e e e e et e e e e et e e e e e eeeeeeeeeeeaaa 3
o IWRB843 UART d D I T oo et e e e e e e e e e e e e et e e e e e e e e e e e 4
o IWRB8A3 T D B e L T i e B e et e e et e e e e e et e e e e et e e e e e e e e e 6
I R A NI RN - = 1= OO O TR O RSO O O RO RTO R OPRRRPR 8
L A= 1= TP ORI 8
o U IR AR T U R U RN A IR oot 9
0 T R B Il e ettt et e et et e e ee e 9
« [LP87524B-Q1. LP87524J-Q1 4A + 2.5A + 2 DD AA v F Wik 1.5A e Ear3—% ] [TPS7TA8101 K /1 X,

JREE, = PSRR, KR 2y 77U AA V=7 - L ¥ a2l —% ] [TPS7TA88-Q1 H#li ], 727 /L 1A /A X
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